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SYNOPSIS

Though India is the largest producer of sugar it does not rank among the best
in terms of sugar quality. Most of the sugar industries use conventional
control techniques, which found fall short of providing effective means of
controlling the processes when the process is complex. With the increasing
demand for better quality and productivity, there is a need to automate the
manufacturing processes. Many processes are however complex, non-linear,
stochastic and even ill defined in some cases. In fact operation of many
processes still relies on the operator's skills due to lack of robust control
methods. However, it is well known that humans, once trained or
experienced, can successfully control various complex systems without
having to depend on mathematical models. This fact leads to the need to
develop intelligent monitoring and control schemes.

In this project, effort has been made for intelligent optimization and control of
complex process to achieve better quality of sugar using intelligent control
schemes based on fuzzy logic, simulink and the simulation is achieved
through the fuzzy-simulink software. Already the data has been collected at
sakthi sugars, manufacturing sugar and beverages.

An attempt has been made to study the entire process of sugar, various
factors that affect the quality of sugar, existing control methods and its effect
on final product. The study aids to develop a new model for underlying non-
linear dynamic process using fuzzy logic and the simulation is performed
using 'simulink ' the simulation software available in the matlab toolbox.

The project is a systematic attempt to design knowledge based fuzzy-simulink
model for a complex system to make the plant to operate safely and
efficiently. The above intelligent control schemes overcome the limitations of

conventional control methods for complex problems.



ABBREVIATIONS

AD — Activation Degrees

Fl _  Fuzzification Interface

FIS —  Fuzzy Inference System

FP —  Functioning Phase

HA —  High Acidic

HL — High Lime
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ICUMSA - International Commission for Uniform Methods of

Sugar Analysis

LA — Low Acidic

LL — LowlLime

LOM —  Largest Of Maximum

LP — Learning Phase

LS —  Low Sulphur

MA —  Medium Acidic

mf —  Membership function
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PID —  Proportional + Integral + Derivative controller
PLC —  Programmable Logical Control
PPM —  Parts Per Million

TRIMF —  Triangular Membership Function
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VHL —  Very High Lime

VHS —  Very High Sulphur
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VLS —  Very Low Sulphur
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1. INTRODUCTION

1.1 Introduction About The Project

Today sugar is the most widely used sweetener. It is most often used to
sweeten foods and beverages. Sucrose is generally known as cane sugar,
which is used as a sweetening agent for foods as in manufacture of candies,
cakes, puddings preserves, soft and alcoholic beverages and many other
foods. Sucrose is a basic foodstuff supply approximately 13 % of all energy
that is derived from foods. Sucrose is a disaccharide that it is made up of two

simple sugars namely glucose and fructose.

The extraction of sucrose from cane sugar is a complex process, which
undergoes several treatments before manufacturing final product. Though
India is the largest producer of sugar, it does not ranks among the best in
terms of sugar quality, since most of the sugar mills in India follows traditional
method of manufacturing sugar which lacks in monitoring and in process
control techniques. In order to produce sugar of superior quality that would be
saleable in international market a cost effective route and modern process

contro! technique s have to be implemented to produce quality sugar.

The conventional method of juice extraction suffers from drawback of pH
control of juice, control of limewater, sulphurdioxide, impurities in juice,
dextrons (bacterial content), control of temperature, pressure, and flow of

juice etc which affects the quality of juice.

Modern control techniques like fuzzy controller (PID controller) and
combination of fuzzy-simulink approach can be used to efficiently control the
process of juice. Improper control of pH, limewater, and sulphurdioxide not

only affects the quality



of sugar but also leads to Abnormal condition of sugar plant. Therefore
information on abnormal events should also be considered important for risk

assessment in process industries.

Thus the operator is forced to focus through large amounts of interrelated
data to identify the causes, which leads to poor quality of sugar. This requires
integration and analysis of large amount numerical and abstract data.
Therefore a knowledge based artificial intelligence system is more
appropriate for such situations. Fuzzy and simulink separately and in
combination, plays an increasingly important role in understanding human
cognition and to simulate human decision making under uncertain and
imprecise environments. They learn from experience with numerical and
linguistic sample data. Learning from samples involves construction of a

model of the system from the knowledge of collection of input-output pairs.

1.1.1 Need and scope of the project
e Lack of experience in modeling on the dynamics of the process
industry.
e Lot of training is required for the proper maintenance of the system
e Continuous improvement of quality which is incorporated with the

process industry.

1.1.2 Aim Of The Project

e To build a model for the manufacturing system

e To have an experience of modeling to integrate Simulink - Fuzzy
computing in the process manufacturing system

o To analyze how the quality is affected or changed with the simulated

model



1.2 INTRODUCTION TO FUZZY LOGIC SYSTEM

1.2.1 Definition:
Fuzzy logic is all about the relative importance of precision: How important is
it to be exactly right when a rough answer will do? .
Here is what some clever people have said in the past about fuzzy logic.
Precision is not truth. - Henri Matisse
Sometimes the more measurable drives out the most important.

- René Dubos
Vagueness is no moré to be done away with in the world of logic than friction
in mechanics. -Charles Sanders Peirce
| believe that nothing is unconditionally true, and hence | am opposed to
every statement of positive truth and every man who makes it.

-H. L. Mencken
So far as the laws of mathematics refer to reality, they are not certain. And so
far as they are certain, they do not refer to reality. -Albert Einstein
As complexity rises, precise statements lose meaning and meaningful
statements lose precision. -Lotfi Zadeh
Fuzzy logic sometimes appears exotic or intimidating to those unfamiliar with
it, but once you become acquainted with i, it seems almost surprising that no
one attempted it sooner. in this sense fuzzy logic is both old and new
because, although the modern and methodical science of fuzzy logic is still

young, the concepts of fuzzy logic reach right down to our bones.

1.2.2 Uses of Fuzzy Logic:

1. Fuzzy logic is conceptually easy to understand.

The mathematical concepts behind fuzzy reasoning are very simple. What
makes fuzzy nice is the “naturalness” of its approach and not its far-reaching

complexity.
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2. Fuzzy logic is flexible.

With any given system, it's easy to massage it or layer more functionality on
top of it without starting again from scratch.

3. Fuzzy logic is tolerant of imprecise data.

Everything is imprecise if you look closely enough, but more than that, most
things are imprecise even on careful inspection. Fuzzy reasoning builds this
understanding into the process rather than tacking it onto the end.

4. Fuzzy logic can model nonlinear functions of arbitrary complexity.
You can create a fuzzy system to match any set of input-output data. This
process is made particularly easy by adaptive techniques like ANFIS
(Adaptive Neuro-Fuzzy Inference Systems), which are available in the Fuzzy
Logic Toolbox.

5. Fuzzy logic can be built on top of the experience of experts.

In direct contrast to neural networks, which take training data and generate
opaque, impenetrable models, fuzzy logic lets you rely on the experience of
people who already understand your system.

6. Fuzzy logic can be blended with conventional control techniques.
Fuzzy systems don't necessarily replace conventional control methods. In
many cases fuzzy systems augment them and simplify their implementation.
7. Fuzzy logic is based on natural language.

The basis for fuzzy logic is the basis for human communication. This
observation underpins many of the other statements about fuzzy logic.

The last statement is perhaps the most important one and deserves more
discussion. Natural language, that which does ordinary people on a daily
basis use, has been shaped by thousands of years of human history to be
convenient and efficient. Sentences written in ordinary language represent a
triumph of efficient communication. We are generally unaware of this because

ordinary language is, of course, something we use every day. Since fuzzy



logic is built atop the structures of qualitative description used in everyday

language, fuzzy logic is easy to use.

1.2.3 An Introductory Example: Fuzzy vs. Non-Fuzzy
A specific example would be helpful at this point. To ilustrate the value of
fuzzy logic, we'll show two different approaches to the same problem: linear
and fuzzy. First we will work through this problem the conventional
(Non-fuzzy) way, writing MATLAB commands that spell out linear and
Piecewise-linear relations. Then we'll take a quick look at the same system
using fuzzy logic.
Consider the tipping problem: what is the “right” amount to tip your

Waitperson? Here is a clear statement of the problem.

Dinner For Two, Repeat

In this section we provide the same two input one output three rule tipping
problem that you saw in the introduction, only in more detail .The basic

structure of this example is shown in the diagram below.

INPUT1 ‘
SERVICE \

s
4y

Rule 1: If service is poor of ranci
Then tip is cheap

OUTPUT
TiP

Rule 2:1f service is good.
Then tip is average
INPUT2
FOOD

Rule 3: If service 18 excellent or
food is delicious. Then tip 18 cheap




The Basic Tipping Problem. Given a number between 0 and 10 that
represents the quality of service at a restaurant (where 10 is excellent), what
should the tip be?

Cultural Footnote This problem is based on tipping as it is typically

practiced in the United States. An average tip for a meal in the U.S. is 15%,
though the actual amount may vary depending on the quality of the service
provided.

1.2.3.1 The Non-Fuzzy Approach

Let's start with the simplest possible relationship. Suppose that the tip always
equals 15% of the total bill.

Tip = 0.15
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This doesn't really take into account the quality of the service, SO We need to
add a new term to the equation. Since service is rated on a scale of 0 to 10,
we might have the tip go linearly from 5% if the service is bad to 25% if the

service is excellent. Now our relation looks like this.
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Tip=0.20/1 0*service+0.05
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So far so good. The formula does what we want it to do, and it's pretty

Straightforward. However, we may want the tip to reflect the quality of the
food as well. This extension of the problem is defined as follows.

The Extended Tipping Problem. Given two sets of numbers between 0 and
10 (where 10 is excellent) that respectively represent the quality of the service
and the quality of the food at a restaurant, what should the tip be?

Let's see how the formula will be affected now that we've added another
variable. Suppose we try

Tip = 0.20/20*(service+food)+0.05;

food (U BRI



In this case, the results look pretty, but when you look at them closely, they
don’t seem quite right. Suppose you want the service to be a more important
factor than the food quality. Let's say that the service will account for 80% of
the overall tipping “grade” and the food will make up the other 20%. Try

ServRatio=0.8;
Tip=servRatio*(0.20/1 0*service+0.05) +...
(1-servRatio)*(0.20/1 0*food+0.05);

focd u servins

The response is still somehow too uniformly linear. Suppose you want more
of a flat response in the middle, i.e., you want to give a 15% tip in general,
and will depart from this plateau only if the service is exceptionally good or
bad. This, in turn, means that those nice linear mappings no longer apply. We
can still salvage things by using a piecewise linear construction. Let’s return
to the one-dimensional problem of just considering the service. You can string
together a simple conditional statement using breakpoints like this.

if service<3,

Tip=(0.10/3)*service+0.05;

elseif service<7,

tip=0.15;

elseif service<=10,

tip=(0.10/3)*(service—7)+0.1 5;



end
The plot looks like this.
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If we extend this to two dimensions, where we take food into account again,
something like this result.

servRatio=0.8;

if service<3,
tip=((0.10/3)*service+0.05)*servRatio + ...
(1—servRatio)*(0.20/1 0*food+0.05);

elseif service<7,

tip=(0.15)*servRatio + ...
(1—servRatio)*(0.20/10*food+0.05);
tip=((0.10/3)*(service—7)+0.15)*servRatio + ..
(1—servRatio)*(0.20/10*food+0.05);

end




The plot looks good, but the_function is surprisingly complicated. It was
a little tricky to code this correctly, and it’s definitely not easy to modify this
code in the future. Moreover, it's even less apparent how the algorithm works

to someone who didn’'t witness the original design process.

1.2.3.2 The Fuzzy Approach

it would be nice if we could just capture the essentials of this problem, leaving
aside all the factors that could be arbitrary. If we make a list of what really
matters in this problem, we might end up with the following rule descriptions.
1. If service is poor, then tip is cheap

2. If service is good, then tip is average

3. If service is excellent, then tip is generous

The order in which the rules are presented here is arbitrary. It doesn't matter
which rules come first. If we wanted to include the food's effect on the tip, we
might add the following two rules.

4. If food is rancid, then tip is cheap

5. If food is delicious, then tip is generous

in fact, we can combine the two different lists of rules into one tight list of
three rules like so.

1. If service is poor or the food is rancid, then tip is cheap

2. If service is good, then tip is average

3. If service is excellent or food is delicious, then tip is generous

These three rules are the core of our solution. And coincidentally, we've just
defined the rules for a fuzzy logic system. Now if we give mathematical
meaning to the linguistic variables (what is an “gverage” tip, for example?) we

would have a complete fuzzy inference system. Of course, there's a lot left to

p— o247
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the methodology of fuzzy logic that we're not mentioning right now, things
like:

¢ How are the rules all combined?

¢ How do | define mathematically what an “gverage” tip is?

The details of the method don't really change much from problem to problem
— the mechanics of fuzzy logic aren't terribly complex. What matters is what
we’'ve shown in this preliminary exposition: fuzzy IS

adaptable, simple, and easily applied.

fesod oo sarvice

Here is the picture associated with the fuzzy system that solves this problem.
The picture above was generated by the three rules above. Thus we have

seen the elaborate introduction about the fuzzy and non-fuzzy approach.

1.2.4 Fuzzy Logic Toolbox:

The Fuzzy Logic Toolbox is a collection of functions built on the MATLAB
numeric computation environment. It provides tools for you to create and edit
fuzzy inference systems within the framework of MATLAB. This toolbox relies
heavily on graphical user interface (GUI) tools to help you accomplish your

work, although you can work entirely from the command line if you prefer.



The toolbox provides three categories of tools:
¢ Command line functions
¢ Graphical, interactive tools

+ Simulink blocks and examples

1.2.5 Steps In Fuzzy Tool Box:

1. Fuzzy Inputs

The first step is to take the inputs and determine the degree 10 which
they belong to each of the appropriate fuzzy sets via membership functions.
In the Fuzzy Logic Toolbox, the input is always a crisp numerical value limited
to the universe of discourse of the input variable (in this case the interval
between 0 and 10) and the output is a fuzzy degree of membership in the
qualifying linguistic set (always the interval between O and 1). Fuzzification of
the input amounts to either a table lookup or @ function evaluation.
2. Apply Fuzzy Operators

Once the inputs have been fuzzified, we know the degree 0 which

each part of the antecedent has been satisfied for each rule. If the antecedent
of a given rule has more than one part, the fuzzy operator is applied to obtain
one number that represents the result of the antecedent for that rule. This
number will then be applied to the output function. The input to the fuzzy
operator is two or more membership values from fuzzified input variables. The
output is a single truth-value.
3. Apply implication Method

Before applying the implication method, we must take care of the rule’'s
weight. Every rule has a weight (a number petween 0 and 1), which is applied
to the number given by the antecedent. Generally this weight is 1 (as it is for
this example) and sO it has no effect at all on the implication process. From

time to time you may want to weight onée rule relative to the others by



changing its weight value to something other than 1. Once proper weighting
has been assigned to each, the implication method is implemented. A
consequent is a fuzzy set represented by a membership function, which
weights appropriately the linguistic characteristic that is attributed to it. The
consequent is reshaped using a function associated with the antecedent (a
single number). The input for the

implication process is a single number given by the antecedent for each rule.
Two built-in methods are supported, and they are the same functions that are
used by the AND method: min (minimum), which truncates the output fuzzy
set, and prod (product), which scales the output fuzzy set.

4. Aggregate All Outputs

Since decisions are based on the testing of all the rules in an FIS, the
rules must be combined in some manner in order to make a decision.
Aggregation is the process by which the fuzzy sets that represent the outputs
of each rule are combined into a single fuzzy set. Aggregation only occurs
once for each output variable, just prior to the fifth and final step,
defuzzification. The input of the aggregation process is the list of truncated
output functions returned to the implication process for each rule. The output
of the aggregation process is one fuzzy set for each output variable.

Notice that as long as the aggregation method is commutative (which
it always should be), then the order in which the rules are executed is
unimportant. Three built-in methods are supported: max (maximum), probor
(probabilistic or), and sum (simply the sum of each rule’s output set).

5. Defuzzify

The input for the defuzzification process is a fuzzy set (the aggregate
output fuzzy set) and the output is a single number. As much as fuzziness
helps the rule evaluation during the intermediate steps, the final desired out
put for each variable is generally a single number. However, the aggregate of

a fuzzy set encompasses & range of out put values, and so must be



output value from the set. Perhaps the
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1.2.6 Structure Of Fuzzy System:
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1.2.8 Advantages Of Using Fuzzy Logic To Build A Model:

1.

o N~ WD

o

Fuzzy logic is conceptually easy to understand. The mathematical
concepts behind fuzzy reasoning are very simple. What makes fuzzy
nice, is the ‘naturalness’ of its approach and not its far reaching
complexity.

Fuzzy logic that is @ qualitative model is highly flexible.

Fuzzy logic is tolerant of imprecise data.

It is used to model non-linear function of arbitrary complexity.

The experts who are having much experience in particular fields can
build fuzzy logic.

Fuzzy logic can be blended with conventional control techniques.

. Fuzzy logic is based on natural language The basis for fuzzy logic is

the basis for human communication.



1.3 INTRODUCTION TO SIMULINK:

1.3.1 Definition:

Simulink is a software package for modeling, simUIating, and analyzing
dynamical systems. It supports linear and nonlinear systems, modeled in
continuous time, sampled time, or a hybrid of the two. Systems can also be
multirate, i.e., have different parts that are sampled or updated at different

rates.

For modeling, Simulink provides a graphical user interface (GUI) for
building models as block diagrams, using click-and-drag mouse operations.
With this interface, you can draw the models just as you would with pencil and
paper (or as most textbooks depict them). This is a far cry from previous
simulation packages that require you o formulate differential equations and
difference equations in a language Or program. Simulink includes a
comprehensive block library of sinks, sources, linear and nonlinear
components, and connectors. You can also customize and create your own

blocks by Writing S-Functions.

Models are hierarchical, so you can build models using both top-down
and bottom-up approaches. You can view the system at a high level, then
double-click on blocks 10 9o down through the levels to see increasing levels
of model detail. This approach provides insight into how a model is organized

and how its parts interact.

After you define a model, you can simulate it, using a choice of
integration methods, either from the Simulink menus 0f by entering
commands in MATLAB’s command window. The menus are particularly

convenient for interactive work, while the command-line approach is very

16



useful for running a batch of simulations (for example, if you are doing Monte
Carlo simulations or want to sweep a parameter across a rangeé of values).
Using scopes and other display blocks, you can see the simulation results
while the simulation is running. In addition, you can change parameters and
immediately see what happens, for “what if’ exploration. The simulation
results can be put in the MATLAB workspace for post processing and
visualization.

Model analysis tools include linearization and trimming tools, which
can be accessed from the MATLAB command line, plus the many tools in
MATLAB and its application toolboxes. And because MATLAB and Simulink
are integrated, you can simulate, analyze, and revise your models in either

environment at any point.

1.3.2 Starting Simulink

To start Simulink, you must first start MATLAB. You can then start Simulink in
two ways:

¢ Click on the Simulink icon on the MATLAB toolbar.

¢ Enter the simulink command at the MATLAB prompt.

On Microsoft Windows platforms, starting Simulink displays the Simulink

Library Browser.

Gimulink: Librawy Bramses
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j: DSP Blockset Systems
Dials & Gauges Block

Monhnear

Sink




The Library Browser displays a tree-structured view of the Simulink block
libraries. You can build models by copying blocks from the Library Browser
into a model window.

On UNIX platforms, starting Simulink displays the Simulink block library

window.

- e n_ £
AT - o oml
s A Y
Sources Sinks pDiscrete Linear Neonlinear Ceonnections

Sy B R aimulink Blade Libran
Toolboxes Copyright (&) 1990-97 by The MathWorks, Ins.

The Simulink library window displays icons representing the block libraries
that come with Simulink. You can create models by copying blocks from the
library into a model window.

1.3.3 Creating A New Model

To create a new model, click the New button on the Library Browser’s toolbar
(Windows only) or choose New from the library window's File menu and
select Model. You can move the window as you do other windows.

1.3.3.1 Building 2 Simple Model

This example shows you how to build a model using many of the model
building commands and actions you will use to build your own models.
The mode! integrates a sine wave and displays the result, along with the sine

wave. The block diagram of the model looks like this.

Sine Wfaue

integratar



To create the model, first type simulink in the MATLAB command window.
On Microsoft Windows, the Simulink Library Browser appears and to create a
new model on Windows, select the New Model button on the Library

Browser’s toolbar.

Gimulink ‘Libray

HEW MODEL BUTTOH
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Continuous
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Functions & T ables Discrete

Math
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.§# Communications Blocks
Control Systern Toolbox Signals &
DSP Blockset Systermns
Dials & Gauges Blockse

Monlinear

ik

Simulink opens a new mode! window.




To create this model, you will need to copy blocks into the model from the

following Simulink block libraries:

% imutink Lib

5 Continuous SIMULIHK LIBRARY

Discrete

R andorn

Functions & T Mumber

Math
MNonlinear
Signals & Syst

Repeating
Sequence

ooaon Signal
Generator

SOURCE LIBRARY

i Communications Blc:
.5 Control System Tool

R e A

5IH WAVE BLOCK

« Sources library (the Sine Wave block)

¢ Sinks library (the Scope block)

¢ Continuous library (the Integrator block)

+ Signals & Systems library (the Mux block)

You can copy a Sine Wave block from the Sources library, using the Library
Browser (Windows only) or the Sources library window (UNIX or Windows).
To copy the Sine Wave block from the Library Browser, first expand the
Library Browser tree to display the blocks in the Sources library. Do this by
clicking on the Sources node to display the Sources library blocks. Finally

click on the Sine Wave node to select the Sine Wave block.



Now drag the SineWave block from the Sources window to your model

window.

Pot

Sine Wave

Copy the rest of the blocks in a similar manner from their respective libraries
into the model window. You can move a block from one place in the model
window to another by dragging the block. You can move a block a short
distance by selecting the block, then pressing the arrow keys.

With all the blocks copied into the model window, the model should look

I 1 O

Sine Wave Soope

Integratof

something like this.
Now it's time to connect the blocks. Connect the Sine Wave block to the top
input port of the Mux block. Position the pointer over the output port on the

right side of the sine Wave block. Notice that the cursor shape changes to

cross hairs.



Finish making block connections. When we done that,our model will look like
this.

Integrator

Now, open the Scopeé block to view the simulation output. Keeping the

Scope window open, set up Simulink to run the simulation for 30 seconds.
First, set the simulation parameters by choosing Simulation Parameters
from the Simulation menu. On the dialog box that appears, notice that the
Stop time is set to 30.0 (its default value).

Close the Simulation parameters dialog box by clicking on the OK button.

simulink applies the parameters and closes the dialog box.

- imulation Patame

STOP TIME PARAMETER
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Choose Start from the Simulation menu and watch the traces of the Scope

block’s input.

The simulation stops when it reaches the stop time specified In the
Simulation parameters dialog pbox or when you choose Stop from the
Simulation menu. To save this model, choose Save from the File menu and
enter a filename and location. That file contains the description of the model.

To terminate Simulink and MATLAB, choose Exit MATLAB (on a Microsoft
Windows system) or Quit MATLAB (on a UNIX system). You can also type
quit in the MATLAB command window. If you want t0 leave Simulink but not

terminate MATLAB, just close all Simulink windows.
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2. LITERATURE SURVEY

The first phase of any research work is to survey the available or existing
literature relevant to the selected topic in order to avoid duplication of work
and to study what is not investigated in that area of the subject. This aspect of
study not only helps to avoid wastage of time, energy and material in carrying
out the basic work by starting from the scratch match, but also helps one to
concentrate on advanced research work from a fairly high level because the
already existing or established methods can be easily adapted for studying or
developing new methods. It was therefore decided to carry out the survey of
the available literature to gain the maximum advantage of it. A brief and

selected review of the relevant available information collected is presented.

In this thesis work the author gives much importance to improve the quality of
sugar using advanced process control techniques and hence the initial phase
of the study begins on conducting literature survey on process details of cane
juice, purity of juice, sucrose content in juice, brix level, factors that affect the
quality of juice and final product, impact of agricultural factors on quality,

Effect of low and high pH of juice, process control technigues e.t.c.

Most of the information about the process details of sugarcane juice s
collected through Internet by means of web address. The entire process
details of sugarcane Wwere collected from the website www.india sugar

online.com/mis/lib-sugar manfa.asp.

The detailed analysis of cane juice, to test and control the pH value, purity,

sucrose content, brix percentage, dextrons, sulphur content, colour of the



juice, moisture content and grades of the sugar are found in the book “gystem
on technical control for sugarcane factories in Indi@’ written by N.C Verma
(1988) pub. The sugarcane technologists association of India — Kanpur
208017 india P.No 54-60.

The formula for calculation of purity of juice pol (sucrose) percentage, brix
percentage, moisture content -ash content and dextron percentage which
helps to determine the quality of sugar is also found in the book “systems on
technical control for sugarcane factories in India” by author N.C Verma (1988)
.chapter IX calculations P.No 145-165.

The detailed analysis is conducted at several stages during processing of
juice for which supporting materials are collected from several books. The
purpose of conducting analysis is to find out whether the process Is with in the
control or out of control. The main factors which affect the quality of sugar
crystals was given by Donavan, M and Williams , J.C (1992) ‘The factors
influencing the transfer of colour to sugar crystals’ proceedings of the 1992
sugar processing conference P .NO 31-48 It was also reported by the author
Shore, M., Broughton, N.W. Dutton, J.V and Sissons,A (1984) ‘Factors

affecting sugar’, Sugar technology reviews, 12 :1-99.

The quality of sugar not only depends on process control technique but also
varies according to the purity of cane juice .The purity of juice, sucrose
content in juice, presence of impurities in juice, dextrin (bacterial content), brix
of juice depends on agricultural factors like presence of nutrients in soil, pH
value of soil, deficiency of nutrients, climatic conditions, post harvesting of
cane, trash content e.t.c. The above details are found in the book namely

‘Developments in sugarcane agriculture that affects processing’ by Legendre



B.L., Clarke MA, Godshall M.A., and Grisham M.P.(1998) ,sugar proc
‘Res.Savannah USA 160-175.

Clarke M.A (1997) Dextron in sugar process paper presented at the ATAM
(Mexican sugar technologists association) conference (1997) , Clarke, S
(1994) cane quality .sugj 56(11): 14 Solomon 'S AK Shrivasta B.Lsrivastava
and V.K Madan 1997 Premilling sugar losses and their management in
sugarcane.lndian institute of sugarcane research publications Lucknow, india
PP 289-310.

The method of separating ~ sugar and molasses, removing
impurities,developing sugar crystals, grain size, colour and grading of the
sugar is explained in the book namely “An innovative process for white sugar
production” by chung chi chou , Kholid Igbal , Y.G Min, Da Wei Gao , and
Emmanuel Duffaut. Sugarcane processing research institute, Inc,New
Orleans, Louisiana 70124 , USA and it was also available in “lmpurity
transfer during A-Massecute of the south Africa sugar technologists
Associates PP 70-75 .

The poor control of pH of cane juice and addition of excess or deficient supply
of limewater and sulphurdioxide gas affects the quality of juice and which
reduces the nature of quality of sugar. Low pH or high pH due to excess
addition of sulphurdioxide or due to excess addition of lime water leads to
transient conditions of the plant by affecting the entire system The details
about pH , effects of low pH and high pH s collected from the book
“Engineering chemistry’” — Chemistry of Engineering materials by Jain and

Jain . chapter 5 and chapter 6 P.No 253-387 The literature was also



collected from the book “Hand book of Industrial water conditioning * by BETZ
(1980) P.NO 81, 105 — 115,122-125.

The second phase of study includes literature survey on fuzzy systems, fuzzy
applications, simulink model and a combined fuzzy-simulink controller. An
advanced process control technique is vital to control a complex process in
better efficient manner than the existing control method to get a desired

output quality of sugar .

A wide literature survey was conducted in above mentioned intelligent
systems by referring various journals, books, and proceedings.

The definition of fuzzy logic, its principles, application of fuzzy logic in control
and signal processing was given by Lofti, Zadeh , the author of the book
“Fuzzy systems and its Appications”. According to Zadeh Fuzzy logic is all
about the relative importance of precision. As complexity arises precise
statement lose meaning and meaningful statements lose precision. The
author says that fuzzy logic is a fascinating area of research because it does

a good job of trading between significance and precision.

According to Munakata and Y.Jain,” Fuzzy systems” An overview
communication.ACM, Vol 37 pp 69-76 March 1994, Fuzziness means
multivaluedness or multivalence. Multivalued fuzziness corresponds to
degrees of uncertainity, partial occurrence of events or relations. Fuzzy logic
can be used in control systems to control the process effectively. The
functioning of fuzzy logic controller is found under the topic “Fuzzy logic in
control system; Fuzzy logic controller - Part 1 “ IN IEEE Trans syst man
cybern by C.C Lee vol 20 pp 404418 mar/Apr 1990 .



The process can be further effectively controlled by developing fuzzy-simulink
controller, where the simulink is used to see the online resuls pbased on the
simulation process according to the dynamic changes in the behaviour of the
system. Once the simulationis done it initiates the fuzzy controller to take
appropriate control actions. Several authors have explained the above control

methods for solving various problems in different fields.

The author also discuss that operation of many complex processes still
depends on operators skill due to lack of robust control methods. Humans
once trained or experienced can successfully control such complex systems
The author stress that fact and emphasis that there is a need to develop an

intelligent monitoring and control schemes for the non-linear process.

The basic idea behind the proposed scheme is first to capture the non-linear
relationship between the operating parameters (control variables) and the
resultant process conditions from empirical data which is collected during
normal operation using the excellent modeling capability of simulink and then
to use the model based fuzzy control scheme proposed by Shin et al (1992)

to determine the control output.

It has been recently reported that Advanced process control technigue can
improve the sugar yield, reduce energy consumption, increase capacity,
improve sugar quality and consistency, improve process safety and reduce

environmental emissions [Anderson, 1992]
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3. PROBLEM DESCRIPTION
3.1 Problem definition

o Though India is the largest producer of sugar and sugarcane it does
not ranks among the best terms of sugar quality.

e The main reason that India couldn't able to produce sugars to meet
international standards is due to failure in implementing advanced
process control techniques.

e The major problem in sugarcane process industry while processing is
improper control of pH of cane juice, milk of lime, sulphur-di-oxide,
presence of impurities in cane juice, grain size of sugar, suspended
matters and colour of the syrup etc affects the quality of sugar.

o There are several other non-technical factors like soil, nutrients, cane
varieties climate, Trash, sucrose and non-sucrose content, nature of
juice etc which also affects the quality of sugar.

o The above problem can be solved by advanced control techniques like
fuzzy-simulink controller.

e A fuzzy-simulink model have been built up using matlab to show the
effect of pH, lime water, sulphurdioxide, impurities and colour of juice
on the quality of the final product

o The quality of sugar manufactured should meet the international
standard ICUMSA (International Commission for Uniform Methods of
Sugar Analysis), which is a worldwide body that brings together the
activities of the National Committees for Sugar Analysis in more than
thirty member countries.

e The effects of factors such as pH of juice, limewater, sulphurdioxide
and other factors which affect the quality of sugar are not sO far

discussed using advanced techniques.



« Implementation of fuzzy-simulink mode! or controller into the real

system

3.2 Factors That Affect The Quality Sugar
1. Nature of Juice
Presence of non-sucrose in cane.
PH of juice.
Excess or deficient supply of limewater and sulphurdioxide.

Brix of lime.

2

3

4

5

6. Brix of juice.
7 Adequate or deficiency of nutrients in soil.
8 Colour of the juice.

9. Temperature and flow control of juice.

10. Delayin harvesting and crushing.

11, Loss of sucrose in cane.

12.  pH of soil.

13.  Trash of cane.

14 Grade and grain size of sugar.

15 Conventional process control methods.

3.3 PARAMETERS USED TO MEASURE THE QUALITY OF SUGAR
There are several parameters to be measured based on which the guality of
the sugar can be tested, graded and confirmed whether it has to be accepted
or not.
Some of the parameters to be measured are
1 Grade of the sugar as per ISS
L31 M31 S31
L30 M30 S30
L29 L29 S29



_ Grade of the sugar as pef ICUMSA

100 -
Between 80 vto 90 -
Between 40t0 70 —
Between 100 to 125 -
Greater than 125 —

~ Grain size

L -
M -
S -
_ Colour of the sugar

Pure White -
Dull White -

Dark Brown -

_ Presence of Sulphur

0 to 16 ppm -
0 -
> 16 ppm -

_ Presence of Lead -

7. Presence of Ash

0 to 0.05% -
> 0.05% -
0 -
Presence of Moisture
0 to 0.04% ~
0 _
>0.05% -

Standard

Good Quality
Superior Quality
Accepted Level

Inferior Quality

Extracourse (> 1mm)
Standard (0.25 TO 0.75 mm)
Small (Or) Fine Grain Size (< 0.25mm)

Superior Quality
Good

Inferior

Accepted
Good
Inferior
Nil

Accepted
Inferior
Good

Accepted

Good

Inferior
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4 METHODOLOGY

4.1 The Engineering Method Of Finding Solution For A Problem

o M N

o

Problem formulation

Setting objectives and project plan

|dentification of initiating events that leads to problem

Analyzing the causes of initiating events

Find out the effect of the problem due to various causes using
cause and effect diagram

Studying the existing method followed its pros and cons.

7. Propose a new model for the problem, using scientific and engineering

8.
9.

knowledge
Data collection and analysis

Constructing a new model

10. Conducting appropriate experiments

11.Manipulate the model to assist in developing solution to the problem

[Model translation}

12 Verifying the model
13.Validating the model

14. Experimental design

15. Documentation and report

16. Draw conclusions or make recommendations based on the problem

solution

17 Implementation and follow up

Y2
3



4.1.1 Problem Formulation

Process plants like sugar plants are pecoming larger and more sophisticated
in terms of capital outlay as well as complexity. This makes it essential for the
process to be controlled properly and efficiently. information on poor control
of process is considered important for risk assessment in process industries
which not only affects the final quality of the sugar but also brings the entire

plant to halt due to abnormal conditions of the sugar plant.

For the process to be successfully executed, it should be continuously
monitored and controlled to find whether the operations are taking place as
per the requirement or not. Hence if anything goes wrong in the process it
pbecomes vital to control the process for which information on process details
is essential for the process operator. Therefore it becomes vital to collect and
organize the overall process data of sugar which aids the process operator in
petter diagnostic of overall process. The operator is forced to focus on large
amount of process data’s which are found to be interrelated and complex in
nature It is not possible for the operator to remember all the process data’s.
Therefore it requires an artificial intelligence system to integrate and analyze
large amounts of numerical and abstract data in order to identify the causes

and effect of the problem.

in case of conventional fault diagnostic system it is difficult to collect and
organize the overall process data of which is found to be a tedious process,
time consuming and may give an inaccurate results. Therefore knowledge
based system like fuzzy, simulink or a combination of fuzzy-simulink

approach is more appropriate for such situations which play an increasingly



important role in understanding human cognition and to simulate human

decision making under uncertain and imprecise environments.

A fuzzy-simulink model is built using matlab to show the effect of pH of juice,
limewater, sulphurdioxide, impurities of juice and colour of the juice on quality
of sugar. The quality of the sugar manufactured should meet the international
standards ICUMSA (International commission of uniform methods of sugar

analysis), which is a world wide body that brings together the activities of the

national committees for sugar analysis in more than thirty member countries.

4.1.2 Setting Objectives And Project Plan

The purpose of conducting study in sugarcane industry is to find the
drawbacks of existing control system and 1o find the effect of the causes of
process variables and other technical and non-technical factors that affects
the quality of sugar The study also includes the details about the proposed
advanced control technique, its structure, method of functioning of new
controller, comparison of functional details and efficiency of existing and
proposed controller etc.

Planning is nothing but estimating the future activities very well in advance
manner. The over all project plan is to conduct a study on manufacturing
quality sugar, collecting various data’s related to sugar quality. Using the
above data’s it was also planned to develop and analyze the structure and
functioning of fuzzy-simulink model based on which a suggestion is forwarded
to the management {0 replace the existing controller by an advanced fuzzy-
simulink controller by explaining its advantages over existing controller in
terms of its efficiency in process control and the impact of its result in final

quality of the product. The cost of the new controller its operating cost and its



implementation cost though not included in the study can also be worked out

and compared with the existing controller.

A new method is proposed because in conventional control method due to
improper and poor control of process, it becomes difficult to manufacture
sugar of superior quality which couldnt be able to compete with the
international standards. By developing and implementing modern control
techniques like fuzzy-simulink controller it hecomes easy to control the entire
process of sugar such as control of pH of juice can be done effectively by
sensing the incoming pH value of mixed juice using a pH sensor. The sensed
pH data's are simulated using simulink and the simulated results are
converted to electrical signals and passed to the PID fuzzy controller. These
electrical sensed signals are converted to multi logic digital values between 0
and 1 and are assigned to the values of various membership functions
according to its significance and preciseness. Based on the assigned values
the PID controller initiates the spring, which controls the opening of the lime
valve and sulphurdioxide gas valve. Fuzzy-simulink controller thus exactly

controls the quantity of limewater and sulphurdioxide to be mixed with juice.

4.1.3 Identification Of Initiating Events
Various factors that determines the nature of quality of sugar are as follows
1. Nature of juice
2 Presence of non —sucrose in cane
3. Low or High pH of juice
4 Excess supply or deficient supply of lime water, sulphurdioxide and
Phosphate
5. Brix of lime
6. Brix of juice

7. pH of sall



8. Nutrients in soil

9. Grade of the sugar

10. Grain size of the sugar

11.Co.|our of the sugar

12.Loss of sucrose in cane

13.Trash content in cane

14.Delay in harvesting and crushing

15. Temperature and flow control of juice
16. Control techniques

17 Other technical and non-technical factors
4.1.4 Analyzing The Causes Of Initiating Events

There are several causes, which initiate or act as hurdles in manufacturing
quality sugar. The main factors to be analyzed are pH of juice, supply of
limewater and sulphurdioxide. Improper control of pH of juice, limewater and
sulphurdioxide gas leads to a major problem in manufacturing sugar of

superior quality.
A brief note of pH of juice

The harvested cane from the field is transported to the sugar industry where
the Cane is crushed by the rollers where the juice is extracted from the
crushed cane .The extracted juice is tested by pH meter to analyze the pH of

juice.

pH describes the degree of acidity or alkalinity of a sugar solution. pH is
measured on a scale of O to 14 The term pH is derived from ‘p the

mathematical symbol of the negative algorithm and ‘H’ the chemical symbol of



hydrogen. The formula definition of pH is the negative logarithm of the
hydrogen ion activity.

pH =-log {H ]

pH provides the needed quantitative information by expressing the degree of
the activity of an acid or base in terms of hydrogen ion activity. The pH value
of a sample juice is directly related to the ratio of hydrogen ion [H "] and the
hydroxyl ion [OH] concentrations. The pH of the juice is tested by a pH
measuring electrode. The glass pH electrode can be considered as a battery
with a voltage that varies with the pH of the measured solution. The pH
measuring electrode is a hydrogen ion sensitive glass bulb, with a muitivolt
output that varies with the changes in the relative hydrogen ion concentration
inside and outside of the bulb. The reference electrode output does not vary
with the activity of the hydrogen ions. The glass pH electrode has high

internal resistance.

If the ‘H’ concentration of the measured sample juice is greater than ‘OH’ than
the sample is treated as acidic in nature which have to be treated with lime
water to increase the concentration of ‘OH’ ions in order to convert it in to
alkaline (base). The main reason for converting the juice from acidity to base

is to remove the impurities found in the mixed juice.

When the sample juice of low pH is treated with lime water, its ‘OH’
concentration increases, which is found to be greater than 7 that ranges
between 8 to 9.2. Once the juice attains the pH value of g 2 the addition of
lime has to be stopped and the impurities present in the juice have to be

filtered out.

The filtered juice whose pH ranges between 8 to 9.2 cannot be sent as such

to the vacuum pans for further processing. It has to be again treated by



sulphurdioxide gas which aids in reducing the base and makes the pH of juice
to reach to a neutral value. The sample is neutral, with a pH of 7 when
amounts of [H 7] and [OH] ions are equal. If the pH of juice (acid or base),
addition of rhilk of lime and sulphurdioxide are not properly controlled then the
result of pH of juice may be of low pH or high pH which severely affect the

final product and the entire processing system.

The process variables like pH of juice, addition of limewater and
sulphurdioxide can be effectively controlled by installing advanced process
controller. The detailed analysis of pH of juice shows data’s on pH ranging
from 4.2 to 5.5 (acidic in nature) , pH ranging from 8 to 9.2 (base-after
treatment of lime) and pH ranging from 7 to 7.1 (after treating juice of high pH
with SO, ). The analysis also suggests that approximate quantity of lime water
should be mixed with juice of low pH (below 7) to convert it to high pH of
alkalinity. The quantity of lime added to juice should vary according to the pH

of juice ranging between 4210

9.2 Similarly the analysis also reveals that quantity of SOz gas to be added to
juice to bring the pH of juice to neutral value should vary according to the pH

of juice ranging between 810 9.2.

The analysis on agricultural factors like pH of soil , nutrients in soil , climatic
conditions, varieties of cane, trash content etc shows that the above factors
plays a vital role in cane growth. Also percentage of sucrose and non-
sucrose content present in the cane , presence of impurities in cane etc

shows serious impact of above factors on final quality of sugar.



4.1.5 To Find Out The Effects Of The Problem
Effect Of Low pH Of Juice

Low pH of juice, whose pH value is less than 7 is acidity in nature, when
processed without proper treatment will affect the parts of the system and
quality of the sugar. Low pH of juice results in formation of scale along the
inner walls of the pipe line, vacuum pans and other parts in the system.
Scales are hard deposits which stick very firmly to the inner surfaces of the
metallic components. Scales are difficult to remove even with the help of
hammer and chisel. Formation of scales due to acidity of juice is the main
source of troubles found in sugar plant. Formation of scale may be due to

1 Decomposition of calcium bicarbonate

2. Deposition of calcium sulphate

3 Presence of silica — Presence of silica in small quantities deposits as

calcium silicate or magnesium silicate. These deposits sticks out very

firmly on the inner side of the metallic parts and react with the metals.
Effects Of Scale Formation

1 Formation of scale causes severity in corrosion in metallic parts of the
plant.

Lowering of safety of the sugar plant.

Decrease in overall efficiency of output.

Danger of explosion

o » WD

It affects the quality of the sugar.
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Prevention Of Scale Formation

External treatment includes efficient softening of water added with crushed
juice and control of pH of juice by adding milk of lime to bring its pH to neutral
value. Internal treatment can be accomplished by adding proper chemicals to
the mixed juice either to precipitate the scale forming impurities in the form of

sludge or to convert them in to compounds which stay in dissolved form.
Effect Of High pH Of Juice

Highly alkaline juice, when processed may cause caustic embrittiement. High
alkalinity of juice may also increases the sulphur content in sugar which is
highly poisonous and may make the sugar unsuitable for consumption.
Caustic embrittlement may cause inner crystalline cracking which has long
been a serious form of metal failure. The failure occurs due to presence of

highly concentration caustic solution [OH] ions in mixed juice.
Effects Of Embrittlement

Severe cracks in pipelines
Leakage of juice in pipe lines.

Severe attack on metals by highly concentrated caustic soda.

A 0N =

High metal stress in the area of concentration.

The other effects are
1 Adding high SO gas to juice may Increase the sulphur content of
juice which is highly poisonous.
2 Low amount of SOz gas added to juice may reduce the colour of the

sugar, since SO2 gas also acts as a bleaching agent.



3. Improper treatment of juice may increase the dextron content in
sugar.

4. Failure on poor analysis of soil may lead to immature cane growth.

5. Failure on nutrient analyses of soil leads to high impurities which may
decrease sucrose content in juice and increase non sucrose
contents.

6. Presence of moisture in sugar exceeding 0.05% may also affect the
sugar quality.

7. The purity of juice decreases due to presence of impurities and non-
sucrose contents in cané juice.

8. Delay in harvesting and crushing may reduce the sucrose content in
cane and increase the percentage of dextron which makes sugar
unsuitable for consumption.

9. Presence of dissolved gases like oxygen and carbon dioxide in cane

juice is highly corrosive and results in serious problems.

4.1.6 propose A New Model For The Problem, Using Scientific And

Engineering Knowledge

Models can be defined as the representation of the real system for the
purpose of studying the system. To create a model, it is vital to study the
entire process of sugar. The success of building up a right type of mode!
depends on accuracy of process data which has been observed and
collected from the on line system. To conduct a detailed study on sugarcane
processing system it is sometime possible to experiment with the system
itself. It is vital to consider certain aspects in processing system that affects
the final quality of sugar. These aspects are represented in the model of the

system.



Generally models can be classified as follows
1. Mechanistic model
2. Black box models
3. Qualitative model
4

. Statistic model
Mechanistic Model

The mechanistic model is usually described from the physics and chemistry
governing the process.

If much is known about the process and its characteristics are well defined
then a set of differential equations can be used to describe its dynamic
behaviour. The mechanistic model can be further classified as follows

a. Lumped parameter models which are described by ordinary differential

equation.

b. Distributed parameter model which use partial differential equations.
Ordinary differential equations are used to describe the behaviour in one
dimension normally time (e.g.) the level of liquid in a tank.

PDE models arise due to dependence on spatial locations. (e.g.)
Temperature profile of liquid in a tank
Both lumped and distributed parameter models can be further classified in to

linear and non-linear descriptions.

Limitations of mechanistic model

Due to financial and time constraints mechanistic model development may
not be practically feasible. Since the process of sugar is so complex and
dynamic in behaviour the resulting equations cannot be solved. Under such
circumstances Empirical or Black box models may be built using data

collected from the plant.
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Black Box Models

Black box or empirical models simply describes the functional relationship
pbetween system input and system output. The parameters of these functions
do not havé any physical significance in terms of equivalence t0 process
parameters such as heat or mass transfer coefficients. Black box models are
very effective in representing some trends in process behaviour. Cost of
modeling is less compared to development of mechanistic models.

Black box models can be further classified in to linear and non-linear forms.
in linear category transfer functions and time series model predominates.
Non-linear category can be further divided in to time series and neural
network based model. In non-linear time series, the non-linear behaviour of
the process is modeled by combination of weighted cross product and

powers of the variables used in the representation.

Qualitative Model

Qualitative models can be used when a situation arise, where nature of the
process may eliminate the mathematical model. (e.g.) When the process is
operated at different process conditions, it results in discontinuities, where
mathematical models cannot be used. The simplest form of qualitative mode!
is the ‘rule-based model that makes use of If-Then —Else constructs 1o
describe the process behaviour.

The rules are made by human expert's ‘Genetic algorithms, fuzzy logic and
neural network can be applied to process data to generate these describing
rules. Qualitative transfer functions is most common suitable for process
control applications. It describes the relation between an input and output
variables.

Models derived based on fuzzy set theory can also be classified as

qualitative models. Fuzzy proposed by LOFTI ZADEH, contains an algebraic

14



and a set of linguistic that facilitates description of complete and ill defined

systems. The fuzzy models are rule based models.

Statistical Models

Describing process in statistical terms is another modeling technique. The
statistical approach is made necessary when there are uncertainties in
process systems.

Out of the above-classified models it is best to select Black box and
Qualitative model to solve the problem because it is simple to construct the
above model, it is economical and efficient in solving problems. The above
models are now widely used to build and solve different kinds of problems in
various fields like in process engineering, Aeronautics, telecommunications,
Aerospace, transportation, air conditioners, automobiles, consumer
electronics, robotics, computers and other industries such as steel, chemical,
power generation, construction, nuclear, medical diagnosis system,

information technology and material processing.

4.1.7 Data Collection And Analysis
Data collection in complex process such as sugarcane process industries is
one of the biggest tasks In solving a real problem. There is a constant
interplay between the construction of the model and the collection of the
needed input data from the sugarcane processing system. Various data’s
collected from sugarcane processing system are as follows.

e pH of cane juice and its range before treatment of lime [4.5 to 5.5]

« Lime water treatment with juice and its range.

« pH of juice after treated with lime [8 to 9.2]

« Addition of SO, gas with juice of alkalinity content and its range.

« pH of juice after SOz gas treatment [7 to 7.1]

e Grade of the sugar



« Grain size of the sugar

e Colour of the sugar

o Sulphur content in sugar

o Lead contentin sugar

« Dextron content in sugar

e Ash and moisture content in sugar
Data's are also collected from sugarcane field which have impact on quality
of sugar and also aids in constructing the model. These input data’s provides
a driving force in constructing a model. The objective of the study will be
fulfiled based on accuracy on the accuracy of the input data collected from
the system. As the complexity of the model changes, the required data
elements may also change. Model structure is valid only if the input data are
accurately collected and properly analysed. The data’s collected from the
sugarcane processing system are found to be adequate in constructing a

model.

Analysis of data

Data’s collected from the sugarcane processing system are properly
analyzed to find whether it is useful to build a model or not. The data’s which
are found to be similar are combined. The similarities of data’s are checked
in successive time periods and during the same period on successive days.
While examining the data’'s the relationship between two variables and its

effect on final product is carefully analyzed.
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5 CONSTRUCTING A NEW FUZZY-SIMULINK MODEL

A new application of FUZZY-SIMULINK system to the processing of sugar IS
developed. Using matlab software package. The first step in constructing a
model is to observe the real sugarcane processing system and the
interaction among its various components and system behaviour. The
second step in model building is construction of a conceptual model by
collection of various data’s and the structure of the system. The third step is
the translation of the operation model in to computer recognizable format.
While building a model there is a need for continuous verification and
validation by comparing the real system to the conceptual model and
repeated modification is done to improve its accuracy.

Mapping an input data vector in to a scalar output using fuzzy logic develops
three fuzzy models of type mamdani. In first model pH of crushed juice is
taken as input and lime water to be added to juice is taken as output and the
mapping between these data’s which are non-linear mapping are performed
using fuzzification, fuzzy inference and defuzzification components found in
fuzzy logic tool box in matlab. Similarly in the second model pH of juice after
treatment of lime water is taken as input and sulphurdioxide to be added to
juice is taken as output and the data’s are mapped in a similar manner and in
the third fuzzy model the parameters which is used to test the quality of sugar
is taken as input and the quality of sugar is taken as output and the data’s
are mapped in a non-linear manner.

The fuzzy system can be integrated with simulink and the model can be
simulated. The fuzzy models can be created using graphical tools or by using

command line functions.
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5.1 CONSTRUCTION OF SIMULINK MODEL WITH OUT FUZZY:
Simulink model:

Simulink model is the process of building (mapping) several input (ph)
to an output (lime) using simulation software. Simulink model includes the
membership function, input port, display unit, subsystem, scope block and

the output port.

5.1.1 MODEL: 1 TREATMENT OF pH OF JUICE WITH LIMEWATER
Aim: To convert pH of juice acidity to pH of juice alkalinity

Input : pH of mixed juice.

Output: Milk of lime

Step by step procedure:

1_Initially to start Simulink, first start MATLAB and then click Simulink icon on
the MATLAB toolbar.

2 To create a new model, click the New button on the Library Browser's
toolbar.

3 Here the model integrates a treatment of ph of juice with lime water and
display the results.

4. To create this model you will need to copy blocks in the model from the
following simulink libraries

+ Sources library (input port block)

¢ Sinks library (input port block the Scope block, display block)

¢ subsystem library (the subsystem block)
.

Signals & Systems library (the Mux block)
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You can copy all the blocks indicated above from the corresponding libraries

by dragging the respective blocks from the respective libraries.
The Model for the TREATMENT OF PH OF JUICE WITH LIMEWATER is

shown below

REACTION OF LIME WATER WITH PH{ ACIDITY ) OF CAME JUICE

Blocks used in the model:

Display block:

It is used to display the numerical input values.

Mux:

It will combine (or) multiplex scalar, vector (or) it will make a multi input into a
single one to obtain the results

Scope block:

The scope block is used to view the results of the model.

Subsystem block:
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This system consists of five rules which will make the ph of juice acidity to ph
of juice alkalinity. This sub system includes input port, membership function

(fro fuzzy logic tool box), display block.

Now we can connect the input port to the various rules and display block. The
output of 5 rules blocks are connected to the mux and are connected to the
scope block (to view the results) and to the output port block.

Now, open the Scope block to view the simulation output. To run the
simulation, first, set the simulation parameters py choosing Simulation
parameters from the Simulation menu. On the dialog box that appears, notice
that the Stop time is set to 6. Close the Simulation parameters dialog box by
clicking on the OK button. Now choose Start from the Simulation menu and
watch the traces of the Scope block’s input by choosing the stop menu we

can stop the simulation. Now the output would look like this

pPH OF JUICE
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5.1.2 MODEL: 2 TREATMENT OF pH OF JUICE WITH SO2

AIM: The main objective of treatment of pH of alkalinity of juice with SO2

Gas is to bring the pH alkalinity of juice to pH neutral value.

Input - pH of mixed juice. (Base)
Output - 80, gas
Step by step procedure:

1 Initially to start Simulink, first start MATLAB and then click Simulink icon on
the MATLAB toolbar.

2. To create a new model, click the New button on the Library Browser's
toolbar.

3. Here the model integrates a treatment of ph of juice with sulphurdioxide

and display the results.

4 To create this model you will need to copy blocks in the model from the
following simulink libraries

+ Sources library (input port block)

¢ Sinks librafy (input port block ,the Scope block, display block)

¢ subsystem library (the subsystem block)

+ Signals & Systems library (the Mux block)

You can copy all the blocks indicated above from the corresponding libraries

by dragging the respective blocks from the respective libraries.
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The Model for the TREATMENT OF pH OF JUICE WITH SO2 is shown

below

SERALL
RESULT

ruled
rule2

I

Mux

INPUT
fule3 )
ouTPUT
led

!

TIME DISLAY

TREATMENT OF PH OF JUICE WITH SULPHURDIOXIDE

Blocks used in the model:

Display block:

it is used to display the numerical input values.

Mux:

It will combine (or) multiplex scalar, vector (or) it will make a multi input into a
single one to obtain the results

Scope block:

The scope block is used to view the results of the model.

Subsystem block:

This system consists of five rules which will make the ph of juice acidity to ph
of juice alkalinity. This sub system includes input port, membership function

(fro fuzzy logic tool box), display block.
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Now we can connect the input port to the various rules and display block. The
output of 4 rules blocks are connected to the mux and are connected to the
scope block (to view the results) and to the output port block.

Now, open the Scope block 1o view the simulation output. To run the
simulation, first, set the simulation parameters by choosing Simulation
Parameters from the Simulation menu. On the dialog box that appears, notice
that the Stop time is set to 14. Close the Simulation Parameters dialog box by
clicking on the OK button. Now choose Start from the Simulation menu and
watch the traces of the Scope block’s input by choosing the stop menu we

can stop the simulation. Now the output would look like this

7 122 124 126 128 13 132 14 3 14

PH OF JUICE



5.1.3 MODEL: 3 DETERMINATION OF QUALITY OF SUGAR

AIM: The main objective is to determine the quality of sugar
Inputs: Grain, Colour, Ash, Moisture, Dextron
Output: Quality

Step by step procedure:

1. Initially to start Simulink, first start MATLAB and then click Simulink icon on
the MATLAB toolbar.

2. To create a new model, click the New button on the Library Browser’s
toolbar.

3 Here the model integrates the determination of quality of sugar and display
the resulits.

4 To create this model you will need to copy blocks in the model from the
following simulink libraries

¢ Sources library (input port block)

¢ Sinks library (input port block the Scope block, display block)

¢ subsystem library (the subsystem block)

¢ Signals & Systems library (the Mux block)

You can copy all the blocks indicated above from the corresponding libraries

by dragging the respective blocks from the respective libraries.
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The Model for the DETERMINATlON OF QUALITY OF SUGAR is shown

below

QUALITY OF SUGAR

Display

DETERMINATION OF QUALITY OF SUGAR

Blocks used in the model:

Display block:

It is used to display the numerical input values.

Mux:

it will combine (or) multiplex scalar, vector (or) it will make a multi input into &
single one o obtain the results

Scope block:

The scope block is used to view the results of the model.

Subsystem block:

This system consists of five rules which will make the ph of juice acidity to ph
of juice alkalinity. This sub system includes input port, membership function

(fro fuzzy logic tool box), display block.
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Now we can connect the input port to the various rules and display block. The

output of 4 rules blo;:ks are connected to the mux and are connected {0 the

scope block (to view the resuilts) and to the output port block.

Now, open the Scope block to view the simulation output. To run the
simulation, first, set the simulation parameters by choosing Simulation
parameters from the Simulation menu. On the dialog box that appears, notice
that the Stop time is set to 200. Close the Simulation Parameters dialog box
by clicking on the OK button. Now choose Start from the Simulation menu

and watch the traces of the Scope block’s input by choosing the stop menu

we can stop the simulation. Now the output would look like this

Grain VS Quality, Ash VS Quality, Colour VS Quality,
Moisture VS Quality, Dextron VS Quality,
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5.2 CONSTRUCTION OF SIMULINK MODEL WITH FUZZY:

Simulink model:

Simulink model with fuzzy is the process of building (mapping) @ model
with the help of fuzzy logic controller already stored in the work space.
Simulink model includes, input port block, fuzzy logic controller with rule

viewer block, scope block and the output port block.

5.2.1 MODEL: 1 TREATMENT OF pH OF JUICE WITH LIMEWATER
Aim: To convert pH of juice acidity to pH of juice alkalinity

input : pH of mixed juice.

Output: Milk of lime

Step by step procedure:
1. Initially to start Simulink, first start MATLAB and then click Simulink icon on

the MATLAB toolbar.

2 To create a new model, click the New button on the Library Browser's
toolbar

3. Here the model utilizes the fuzzy logic controller with rule viewer for a
treatment of ph of juice with lime water and display the results.

4. To create this model you will need to copy blocks in the model from the
following simulink libraries

+ Sources library (digital clock block)

¢ Sinks library (the Scope block, out port block)

o Fuzzy logic toolbox library (fuzzy logic controller with rule viewer block)
You can copy all the blocks indicated above from the corresponding libraries
by dragging the respective blocks from the respective libraries.

Now we can connect all the blocks and the model will look like this
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The Mode! for the TREATMENT OF PH OF JUICE WITH LIMEWATER

ALONG WITH FUuzzy CONTROLLER is shown below

— Fuzzy Logic

D t t
tghinpy arget Contraller
with Ruleviewers

SIMULINK MODEL FOR THE

REACTION OF LIME WATER WITH PH({ ACIDITY ) OF CANE JUICE
WITH FUZZY LOGIC CONTROLLER

simulation menu to start the simulation. Set the close time to stop

Open the
e simulation output.

the simulation. Now, open the Scope block to view th

Now the output would look like this

o
&)
-

3 1

&=
et

PH OF JUICE
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5.2.2 MODEL: 2 TREATMENT OF pH OF JUICE WITH SO2

Aim : The main objective of treatment of pH of alkalinity of juice with SO,
Gas is to bring the pH alkalinity of juice to pH neutral value.
Input - pH of mixed juice. (Base)

Output - S0, gas

Step by step procedure:

1. Initially to start Simulink, first start MATLAB and then click Simulink icon on
the MATLAB toolbar.

2 To create a new model, click the New button on the Library Browser's
toolbar

3 Here the model utilizes the fuzzy logic controller with rule viewer for a
treatment of ph of juice with sulphurdioxide and display the results.

4. To create this model you will need to copy blocks in the mode! from the
following simulink libraries

¢ Sources library (digital clock block)

¢ Sinks library (the Scope block, out port block)

¢ Fuzzy logic toolbox library (fuzzy logic controller with rule viewer block)
You can copy all the blocks indicated above from the corresponding libraries
by dragging the respective blocks from the respective libraries.

Now we can connect all the blocks and the model will look like this



The Model for the TREATMENT OF pH OF JUICE WITH SO2 ALONG WITH
FUzzy CONTROLLER is shown below

Scope

Fuzzy Logic
Controller
with Ruleviewer

Digiinput target

STMULINK MODEL FOR THE
TREATMENT OF PH OF JUICE WITH SULPHURDIOXIDE
WITH FUZZY LOGIC CONTROLLER

Open the simulation menu to start the simulation. Set the close time to stop
the simulation. Now, open the Scope block to view the simulation output.

Now the output would look like this
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5.2.3 MODEL: 3 _DETERMINATION OF QUALITY OF SUGAR

AIM: The main objective is to determine the quality of sugar
Inputs: Grain, Colour, Ash, Moisture, Dextron

Output: Quality

Step by step procedure:

1. Initially to start Simulink, first start MATLAB and then click Simulink icon on
the MATLAB toolbar.

2. To create a new model. click the New putton on the Library Browser's
toolbar

3 Here the model utilizes the fuzzy logic controller with rule viewer for the
determination of quality of sugar and display the results.

4. To create this model you will need to copy blocks in the model from the
following simulink libraries

¢ Sources library (digital clock block)

¢ Sinks library (the Scope block, out port block)

¢ Fuzzy logic toolbox library (fuzzy logic controller with rule viewer block)
You can copy all the blocks indicated above from the corresponding libraries
by dragging the respective blocks from the respective libraries.

Now we can connect all the blocks and the model will look like this
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The Model for the DETERMINATION OF QUALITY OF SUGAR ALONG
WITH THE FUZZY CONTROLLER is shown below

Digiinput targe

12:34
Fuzzy Logic
Controller

——

Mol with Ruleviewer

STMULINK MODEL FOR THE
DETERMINATION OF GUALITY OF SUGAR
WITH FUZZY LOGIC CONTROLLER

Open the simulation menu to start the simulation. Set the close time to stop

the

simulation. Now, open the Scope block to view the simulation output.

Now the output would look like this

(a)

Results With Out Fuzzy (b) Results With Fuzzy

(a) Grain VS Quality (b) Grain VS Quality
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: Surface Viewer. 0

(a) Moisture VS Quality (b) Moisture VS Quality

(a) Colour VS Quality (b) Colour VS Quality



(a) Dextron VS Quality (b) Dextron VS Quality

(b) Ash VS Quality

(a) Ash VS Quality
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6 RESULTS AND DISCUSSION

In this thesis work the quality of sugar is determined by considering various
factors which have an impact on quality using fuzzy-simulink approach and an
advanced fuzzy-simulink process controller is developed and its control

technique is compared with the existing Automatic fuzzy pH controller.

The fuzzy-simulink model is developed in matiab using the sample data’s of
pH of juice, milk of lime, sulphurdioxide and other quality testing parameters
collected from the process expert in the sugar industry. It has been observed
that poor control technique fails to sense the pH of juice accurately and it
leads to excess or less addition of lime water and sulphurdioxide which fails
to achieve the desired pH value of juice .It was also observed that low pH or
high pH of juice not only affects the final quality of the product but also affects
the entire operation of sugar plant due to transient conditions of the plant. The
collected online process data’s of critical process variables are created using
the simulink model till the desired values are achieved. A fuzzy model is
created using If-Then rules. By combining simulink model and fuzzy logic a
fuzzy-simulink controller is developed which is an Advanced process

controller that overcomes the drawbacks of existing fuzzy PID controller..

The problem is solved by developing a fuzzy-simulink model for a continuous
process using matlab package. This Advanced fuzzy-simulink controller can
learn this dynamic behaviour of the process and change the parameters
automatically, according to which it controls the addition of limewater and

sulphurdioxide gas with juice.

Three fuzzy models are built for continuous process in sugar industry. The

result of the first model depicts that for increasing pH value of juice from O to
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6, the limewater to be added to juice is found to be gradually decreasing.
From the above result it was conciuded that pH and limewater are
inversionally proportional to each other. If pH is 0.3 (High acidity), then high
amount of lime, say 2.5g / litre is added to juice to convert pH of acidity to
alkalinity. When pH of juice increases then the amount of lime water to be
added to juice is found to be in decreasing rate and when pH approaches to 6

milk of lime to be added declines to zero.

The result of the second model shows that for increasing pH value of juice
from 7 to 14 , the sulphurdioxide to be added to juice is found to be gradually
increasing.From the above result it was concluded that pH and sulphurdioxide
are directly proportional to each other.If pH is 7.5 (Very Low alkalinity), then
very low amount of sulphur dioxide gas is sufficient say 0.2 ppm / litre is
added to juice to convert pH of alkalinity to pH neutral. When pH of juice
increases then the amount of sulphurdioxide gas to be added to juice is
found to be in increasing rate and when pH approaches to 14 sulphurdioxide

gas to be added reaches maximum.

The final fuzzy model is the model built to determine the quality of sugar and
to find the relationship between quality and other quality measuring
parameters like grain size, colour, ash, moisture and dextrin. The result of the
final model shows that these input quality parameters have serious impact on
sugar in terms of sugar quality. Though there are several other quality
parameters which are not mentioned in this model due to its complexity
nature , grain size and colour are considered to be the most important
parameters in fixing the quality of sugar.

It was found that if colour is greater than 120 (unacceptable) and grain size is
fine ( < 0.25) then quality of the sugar is found to be highly Inferior (Quality is
below 30)
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If the colour of the sugar is below 120 (Acceptable), and grain size is 1
(Extracourse) then the quality of the sugar is found to be between 60 to 70%
(Average). _

If the colour of the sugar is found to be between 75 to 100 (White) and grain
size is between 0 to 0.5 mm (Fine size) then quality of the sugar is just above
60% (Average)

If the colur of the sugar is between O to 50 (Pure white) and grain size is
above 0.5 mm then quality of the sugar lies between 70 to 85% (Good).

If the grain size is above 1 mm and the colour of the sugar is less than 50, the
quality of the sugar is above 85% (Superior).

If the grain size is less than 0.5 mm (Fine) and ash content of sugar is found
to be less than 0.05% (Accepted level), then the quality of the sugar is below
50% (Inferior). Also if the grain size is between 0.5 to 1 mm and even the ash

content is above 0.05 ppm the quality of the sugar is below 50%.
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7 CONCLUSION

This thesis _study is an organized approach to solve the quality problem in
sugar industry using advanced process control technigues, where number of
process variables involved is high. These process variables are interrelated
with each other. A change in one variable may affect the other and may have
a serious impact on the final quality of sugar. Therefore the process has to be

monitored and controlied by installing advanced automatic process controller.

Under this study, various problematic areas are identified in existing method
and an advanced controller namely fuzzy-simulink controller has been
developed using available data. The development of fuzzy-simulink controller
accurately senses, trains and accordingly it control the process variable,

which aids the sugar industry to produce quality sugar.

The move towards advanced process control technique namely fuzzy-
simulink controller is definitely a boon to the company since it accurately
controls the process variables according to the dynamic change in the

behaviour of the system.

There is lot of procedures involved in implementing advanced process control
technique. It can only run on trial basis till the process engineers are satisfied
with its control performance. Once they are satisfied the next step is to
interface the automatic pH fuzzy-simulink controller to the computer, where
the online process can be continuously governed, trained and controlled by

the user using the system itself.
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